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1 Aminosaure-Sequenzvergleiche und Proteinstrukturen

In vielen Standard-Lehrbichern findet man im Evolutionskapitel zu Homologien auf molekularer Ebene
Abbildungen von Ausschnitten der Aminosaure-Sequenzen verschiedener Arten [1], [2].

Aus dem Vergleich der Aminosaure-Sequenzen wird dann haufig ein daraus abgeleiteter molekularer
Stammbaum angegeben. Daneben zeigen manche Biicher die Ahnlichkeit des gleichen Proteins bei
verschiedenen Arten zusatzlich auch auf Ebene der Tertiarstruktur anhand einer raumlichen Darstellung
der gesamten Polypetidkette [3].

Als Schuler kann man durch Nachvollziehen dieses Einfihrungslehrgangs ein tieferes Verstandnis sowohl
fur die Realisierung der genetischen Information gewinnen, als auch fir die Bewertung von Homologien
auf molekularer Ebene.

Als Lehrer kann man die hier vorgestellten Software-Werkzeuge und Methoden fir die eigene
Unterrichtsvorbereitung und nicht zuletzt auch fur die grafische Gestaltung von Leistungserhebungen mit
selbst gewahlten Beispielproteinen nutzen.

Die Kapitel 1.1.4 und 1.2.4 beschaftigen sich erganzend mit der Anfertigung diesbeziiglicher Abbildungen
unter Zuhilfenahme TEX basierter Textsatzprogramme flr wissenschaftliche Arbeiten, etwa im Rahmen

einer W-Seminararbeit. Fir die Bewertung der Aussagekraft von Abbildungen in Fachzeitschriften oder
Blchern ist es sicher hilfreich, sich auch der Einschrankungen bewusst zu sein, die mit der technischen
Umsetzung einhergehen.

1.1 Aminséure-Sequenzvergleich vier verschiedener Arten am Beispiel von Cytochrom
b561

1.1.1 Suche in der UniProt-Proteindatenbank
www.uniprot.org > Tab: Search > Button: Advanced Search > Field > Protein Name [DE]: Cytochrome b561

Entry Entry name Status Protein names Gene names Organism Length
POABES C561_ECOLI Cytochrome b561 cybB b1418 Escherichia coli 176
‘ JW5224 (strain K12)
P49447 CY561 _HUMAN Cytochrome b561 CYB561 Homo sapiens 251
: (Human)
Q60720 CY561_MOUSE Cytochrome b561 Cyb561 Mcyt Mus musculus 250
‘ (Mouse)
, POABE6 C561_ SHIFL Cytochrome b561 cybB SF1794 Shigella flexneri 176
‘ S1478

Tipp: Um die englische Bezeichnung z.B. eines Proteins oder einer Art zu erhalten, kann man einfach
zunachst den deutschsprachigen Wikipedia-Artikel (de.wikipedia.org/wiki/Cytochrome) aufrufen und dann
im linken Seitenmenu unter In anderen Sprachen > English auswahlen.

Fir einzelne Begriffe oder kurze Texte kann auch unter translate.google.com der zu Gbersetzende Text
einfach direkt (ibersetzt werden, wobei beim Uberfahren der Wérter im Zielfeld ein Auswahlmeni fiir
mogliche Synonyme erscheint.



http://translate.google.com/
http://de.wikipedia.org/wiki/Cytochrome
http://www.uniprot.org/uniprot/P0ABE6
http://www.uniprot.org/uniprot/Q60720
http://www.uniprot.org/uniprot/P49447
http://www.uniprot.org/uniprot/P0ABE5
http://www.uniprot.org/

Einfiihrung in die Bioinformatik (Jakob 2012) 3/27

1.1.2 Aminoséure-Sequenzverqgleich direkt im Webbrowser durchfiihren

Oben wechselt man nun innerhalb der UniProt-Seite in den Tab: Align und kopiert die Eintrage aus der
Spalte Entry name aus der unten auf der Webseite weiterhin angezeigten Ergebnisliste manuell ganz oben
in das Feld Sequences (in FASTA format) or UniProt identifiers jeweils in eine neue Zeile und klickt
anschlief3end rechts daneben den Button: Align an:

C561_ECOLI
C561_SHIFL

CY561_HUMAN
CY561_MOUSE

Der Vorteil dieser Methode besteht darin, dass die spatere Reihenfolge der Zeilen in der
Sequenzvergleichs-Darstellung einfach lber die Abfolge der eingegebenen UniProt identifier selbst
festgelegt werden kann.

Nach einer kurzen Wartezeit erscheinen dann unten u.a. die beiden Abschnitte Alignment
(Sequenzvergleich) und Tree.

Rechts neben dem Alignment kann die Ansicht im Webbrowser dann noch nach verschiedenen Kriterien
(wie z.B. Ahnlichkeit, Polaritat, Ladungen) eingefarbt werden, z.B. unter Amino acid properties > Similarity.
Far die Darstellung wird eine nichtproprotionale Schriftart mit fester Breite (Monospace) wie Courier
New gewahlt:

R 0 POABE5 (C561_ECOLI
I R 0 POABE6  (C561_SHIFL
1 MEGGAAAATPTALPYYVAFSQLLGLTLVAMTGAWLGLYRGGIAWESDLQFNAHPLCMVIG 60 P49447  CY561_HUMAN
1 -MEHSSASVPAALPYYVAFSQLLGLTVVAVTGAWLGLYRGGIAWESSLQFNVHPLCMVIG 59 Q60720  CY561_MOUSE
1 e MENKYSRLQISIHW- - LVFLLVIAAYCAMEFRGFFPRSDRPLINMI ~ 44 POABE5  (C561_ECOLI
1 e MENKYSRLQISIHW- - LVFLLVIAAYCAMEFRGFFPRSDRPLINMI ~ 44 POABE6  C561_SHIFL

61  LIFLQGNALLVYRVFRNEAKRTTKVLHGLLHIFALVIALVGLVAVFDYHRKKGYADLYSL 120 P49447  CY561_HUMAN
60  MIFLQGDALLVYRVFRREAKRTTKILHGLLHVFAFIIALVGLVAVFDYHKKKGYADLYSL 119 Q60720  CY561_MOUSE

N o o E N
45 HVSCGISILVLMVVRLLLRLKYPTPPIIP------- KPKPMMTGLAHLGHLVIYLLFIAL 97 POABES C561_ECOLI
45 HVSCGISILVLMVVRLLLRLKYPTPPIIP------- KPKPMMTGLAHLGHLVIYLLFIAL 97 POABE6 C561_SHIFL
121 HSWCGILVFVLYFVQWLVGFSFFLFPGASFSLRSRYRPQHIFFG------ ATIFLLSVGT 174 P49447 CY561_HUMAN
120 HSWCGILVFVLYFVQWLVGFSFFLFPGASFSLRSRYRPQHIFFG------ ATIFLFSVGT 173 Q60720 CY561_MOUSE
* FkEk o %% e %o . . * o % . o % *ek o .

98  PVIGL--VMMYNRGNPWFAFGLTMPYASEANFERVDSLKSWHETLANLGYFVIGLHAA-A 154 POABE5  (C561_ECOLI
98  PVIGL--VMMYNRGNPWFAFGLTMPYASEANFERVDSLKSWHETLANLGYFVIGLHAA-A 154 POABE6  C561_SHIFL

175 ALLGLKEALLFNLGGKYSAFEPE------ GVLAN------------ VLGLLLACFGGAVL 216 P49447 CY561_HUMAN

174 ALLGLKEALLFKLGSKYSTFEPE------ GVLAN------------ VLGLLLVCFGVVVL 215 Q60720 CY561_MOUSE
.o k% ceee % . o . % oo .

155 ALAHHYFWKDNTLLR----- M----MPRKRS---- 176 POABES C561_ECOLI

155 ALAHHYFWKDNTLLR----- M----MPRKRS---- 176 POABE6 C561_SHIFL

217 YILTRADWKRPSQAEEQALSMDFKTLTEGDSPGSQ 251 P49447  CY561_HUMAN
216 YILAQADWKRPSQAEEQALSMDFKTLTEGDSPSPQ 250 Q60720  CY561_MOUSE

*% : . * *
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1.1.3 Herunterladen der Sequenzinformationen im FASTA-Format

Man wahlt nun die orangefarbene Schaltflache rechts oberhalb des Alignments und speichert
diese Datei fiir die weitere Bearbeitung unter dem Dateinamen cytochromvergleich. fasta lokal auf
dem eigenen Rechner ab. Im Gegensatz zu dem Uber die griine Bearbeitungsleiste erreichbaren Button
Retrieve liefert diese Methode in den Fasta-Dateien auch die mit Minuszeichen entwerteten Leerstellen
mit, falls sich die Kettenldngen unterscheiden und es daher an manchen Stellen in der anderen Kette
keine entsprechenden Aminosauren gibt. Diese ,Gaps” (= Licken) sollten aber nicht zu viele Bausteine
umfassen.

1.1.4 Druckausgabe fiir wissenschaftlichen Artikel mit dem LaTeX Paket Texshade erzeugen

Nun legt man im Programm Texmaker die folgende Datei alignment_cytochrome. tex an:

\documentclass[10pt,adpaper]{article}
\usepackage[utf8]{inputenc}

\usepackage{amsmath}

\usepackage{amsfonts}

\usepackage{amssymb}

%TexShade Paket benutzen

\usepackage{texshade}

\begin{document}

%vorher unter 1.1.3 gespeicherte Dateil cytochromvergleich.fasta benutzen
\begin{texshade}{cytochromvergleich.fasta}
%Zeilenumbruch nach 60 Aminsduren pro Zeile
\residuesperline*{60}

%Einfarbemodus nach Ahnlichkeit/Similarity
\shadingmode[allmatchspecial]{similar}

%Bereichsauswahl von der 1. bis maximal 251. Aminosdure
\setends{1}{1..251}

\hideconsensus

\end{texshade}

\end{document}

Es wird eine PDF-Datei mit dem folgenden Inhalt erzeugt:

Sequenzvergleich Cytochrom ba61

SpIPOABEG |CE61_ECOLL . ..ottt i it ettt e s ta ittt e aeaa it st s e e st a e 0
SpIPOABEG [CBB1_SHIFL . . .t ettt et e a e et e e e e e e e e et e et e e e e e e e e e e 0
sp|P49447 |CY561_HUMAN MEGGAARIA ALPYYVAFSQLLGLTIRVARNTGAWLGLYRGGIAWESHLOQFNEHPLCMVIG 60
splQ60720|CY561_MOUSE .MEHSSEASVIRARNAR SV EIANGR ANTGAWLGLYRGGIAWESKLOQFNYHPLCMVIG 59
sp|POABES |CB61_ECOLT  .............. MENEYSEILG IE CHME FQSDHPLINMI 44
sp|POABEE |C561_SHIFL . ............. MENEKYSHLQI] CEME F SDRPLINMI 44
sp|P49447 |CYEE1_HUMAN ALL‘&'YR FRIEA KV ALVGLVEVED HRKH“DHSL 120
splQ60720|CYs61_MOUSE Ming#e[eDEYARR S FRREA KI FIIWALVGLVEVFDEHEK DLESL 119

sp|POABES |C561_ECOLI IVS ST M LIFL LKIPIP FIIP....... a7
sp|POABEE | C561_SHIFL IVS ST M LIFLRI. KMPEPISTIP. . . .... a7
sp|P49447 |CYE61_HUMAN [ilS LV FyQW FSFFLF 5 }

splQ60720|CYEE61_MOUSE [IS LV FL QW FSFFLF Sﬁ

P

sp|POABES |C561_ECOLI  PVI[HR. . VMM PWF I} MPYASE i3 154
sp|POABEE |C561_SHIFL  PVI[HHR. . VMM PWF| I} MPYASE 13 154
sp|P49447 |CYEE1_HUMAN L LLFuLEeGKMSENIEPE 216
splQ60720|CYE61_MOUSE L LLFKL{ESK@EST|JEPE 215

sp|POABES |C561_ECOLI AL YFOJADNMLLE. . . . . [
sp | POABE6 |C561_SHIFL AL YFEADNEL

sp|P49447 |CY561_HUMAN YILTRAD PS50 ; )
splQ60T20|CYEE61_MOUSE YILAQAD PSQ ; )
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1.1.5 Baumansicht online und mit lokalem Programm erzeugen

Befindet man wie in Kapitel 1.1.2 im Tab: Align , so wird unten im Abschnitt Tree ein einfacher abgeleiteter
Stammbaum flir das zuvor durchgefiihrte Alignment angezeigt:

Guide tree

BABES  C561_ECOLT

| boABEE €561 SHIFL
P49447  CYSGEI_HUMAN

A — i )

[ (ee720  CYSAL_MOUSE [ Taxonomy

Highlight

Weg 1 mit online-ClustalW-Werkzeug:

Die unter 1.1.3 gespeicherte Datei cytochromvergleich. fasta kann tber den Button Durchsuchen
auf der Webseite www.ebi.ac.uk/Tools/phylogeny/clustalw2_phylogeny hochgeladen werden. Diese bietet
die online-Nutzung des im Weg 2 lokal installierten Programms Clustalw/x. Die Berechnung wird mit
Submit gestartet. Auf der Ergebnisseite wird im Absatz Phylogenetic Tree der Quelltext des Baumes
angezeigt und darunter im Absatz Phylogram/Cladogram im Wechsel die beiden Ansichtsoptionen
Cladogram Tree und Phylogram Tree.

Phylogramm:

| Sp|POABES|CS561_ECOLI: ¢.00000
| 5p|POABE6|CS561_SHIFL: 0.00000

sp|P49447|CYS61_HUMAN: 0.04226
sp|Q60720|CY561_MOUSE: 0.02174

Cladogramm:

— sp|POABES|CS61_ECOLI: 0.00000
L sp|POABEG|CS61_SHIFL: 0.00000

sp|P49447|CY561_HUMAN: 0.04226
sp|Q60720|CY561_MOUSE: 0.08174

Moéchte man nur die Daten des Baums speichern, wahlt man die Optione View Phylogentic Tree File und
speichert die dann im Browser angezeigte PHYLIP FORMAT TREE-Datei als
cytochromvergleich_baum.ph lokal ab.

Weg 2 mit lokal installiertem ClustalX-Programm:
Man kann die Baumdatei alternativ auch mit dem 0D

lokal installierten Programm Clustalx erzeugen, CylechromyerglelchiE AP (RUPS)
indem man unter File > Load Sequences die unter
1.1.3 gespeicherte Datei (Operat ion
Cytochromve rgleich .fasta ladt und unter “*Full tree - New outgroup - Swap nodes < Subtres
Trees > Draw Tree den Baum als %ﬂﬂ
cytochromvergleich_baum.ph lokal LSS

File Edit Font Paper Help |

rDisplay
I7 Branch lengths I =

AR

abspeichert. 008 0.1
——=3plQE0720ICY 561_MOUSE

Egal auf welchem Weg sie erzeugt wurde, 6ffnet

man anschlieRend diese Datei mit mit dem lokal 0.333

installierten Programm NJPlot und erzeugt den

folgende Baum (rooted = mit Wurzel): 004 b 404471CY 561_HUMAN

Unter Display > Branch lengths werden die Abstéande
auf den Asten angezeigt.

Unter File > Save as Postscript kann dann eine
Postscript Datei mit der Endung ps erzeugt werden,
die dann entweder direkt ausgedruckt oder nach
einem Import mit einem Bildbearbeitungsprogramm
wie Gimp weiterverarbeitet werden kann.

splPOABESGIC561_SHIFL

0.395

splPOABESIC361_ECOLI



http://www.gimp.org/
http://www.ebi.ac.uk/Tools/phylogeny/clustalw2_phylogeny/
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Alternativen bieten die Programme Treeview (taxonomy.zoology.gla.ac.uk/rod/treeview.html), TreeViewX
(code.google.com/p/treeviewx) und Tree-Puzzle (www.tree-puzzle.de)

Mit dem Programm CDTree (nur Windows und Mac, www.ncbi.nlm.nih.gov/Structure/cdtree/cdtree.shtml)
kénnen auch weiterfiihrende Analysen durchgefiihrt werden.

Tipp: Einen interaktiven Uberblick Uber aktuelle Verwandtschaftsbeziehungen aufgrund molekularer
Abstande bietet die Webseite Interactive Tree of Life (itol.embl.de).

1.2 Aminsédure-Sequenzvergleich am Beispiel Fasciculin (Schlangengift)

1.2.1 Suche in der UniProt-Proteindatenbank
www.uniprot.org > Search > Fasciculin

Entry Entry name Status Protein names Gene Organism Length
names

‘ POC1Y9 TXFA1_DENAN Fasciculin-1 Dendroaspis 61
' angusticeps
(Eastern green
mamba)
P01391 NXL1_NAJKA Long neurotoxin 1 Naja kaouthia 71

(Monocled cobra)
(Naja siamensis)

P60615 NXL1A_ BUNMU Alpha-bungarotoxin Bungarus 95
) isoform A31 multicinctus
(Many-banded
krait)

Folgt man einzelnen Eintragen auf ihre Seiten, z.B. www.uniprot.org/uniprot/POC1Y9
so findet man dort im Absatz General annotation (Comments) im Abschnitt Sequence similarities den Hinweis:
Belongs to the snake three-finger toxin family. Acn-esterase inhibitor subfamily.

Hinweis: Bei der Suche zu Fasciculin finden wir in der Ergebnistabelle neben den drei oben verglichenen
Schlangengiften auch die menschliche Acetylcholinesterase:

Entry Entry name Status 'Protein names 'Gene Organism Length
names
O P22303 ACES_HUMAN r Acetylcholin- ACHE Homo sapiens 614
esterase (Human)

1.2.2 Alignment direkt im Webbrowser durchfiihren

AnschlieRend fuhrt man ein Align aus, indem man die Eintrage der drei Entry name Felder wie folgt im Tab
Align in das entsprechende Eingabefeld Sequences (in FASTA format) or UniProt identifiers eintragt:

TXFA1_DENAN
NXL1_NAJKA
NXL1A_BUNMU

Nach der Auswahl von Align, erhalt man die folgende Anordnung:


http://www.uniprot.org/uniprot/P22303
http://www.uniprot.org/uniprot/?query=family:%22snake+three-finger+toxin+family.+Acn-esterase+inhibitor+subfamily%22
http://www.uniprot.org/uniprot/?query=family:%22snake+three-finger+toxin+family%22
http://www.uniprot.org/uniprot/P0C1Y9
http://www.uniprot.org/uniprot/P60615
http://www.uniprot.org/uniprot/P01391
http://www.uniprot.org/uniprot/P0C1Y9
http://www.uniprot.org/
http://itol.embl.de/
http://www.ncbi.nlm.nih.gov/Structure/cdtree/cdtree.shtml
http://www.tree-puzzle.de/
http://code.google.com/p/treeviewx/
http://taxonomy.zoology.gla.ac.uk/rod/treeview.html
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1  eeemeeeacicaiaeaaans TMCYSHTTT - SRATLTNCGENSCYRKSRRH- - - - - - PPK 32 POC1Y9  TXFA1_DENAN

1 eeemeememeeciaaaaas IRCF - - ITPDITSKDCP-NGHVCYTKTWCDAFCSIRGKR 36 PO1391  NXL1_NAJKA

1 MKTLLLTLVVVTIVCLDLGYTIVCHTTATSPISAVTCPPGENLCYRKMWCDAFCSSRGKV — 60 P6@615  NXL1A_BUNMU
* * . *% *

33 MVLGRGCGCPPGDDYLEVKCCTSPDKCNY- - - - - - - 61 POC1Y9  TXFA1_DENAN

37  VDLGCAATCPTVKTGVDIQCCST-DNCNPFPTRKRP 71 P01391  NXL1_NAJKA
61  VELGCAATCPSKKPYEEVTCCST-DKCNPHPKQRPG 95 P60615  NXL1A_BUNMU

R B H

Ein Sternchen ,** bedeutet vollige Ubereinstimmung, ein Doppelpunkt ,:“ sehr ahnlich, ein einfacher Punkt
. ahnlich. Wahlt man in der rechten Spalte unter Amino acid properties > Similarity aus, so werden bei
allen verglichenen Proteinen konservierte Bereiche hellgrau unterlegt.

Wahlt man in der rechten Spalte unter Annotation > Disulfide bond aus, wird die Aminosaure Cystein
hellblau unterlegt.

Beobachtung:
* Man erkennt hier eindeutig, dass die Aminosauresequenz v.a. an den Cysteinresten sehr
konservativ ist.

Interpetation:
* Die Disulfidbriicken sind entscheidend fiir den tbergeordneten raumlichen Bau der Tertiarstruktur
und somit fur die Funktionsweise dieser Toxine.

1.2.3 Abbildung der 3D-Ansicht eines bestimmten Proteins mit bestimmten Einstellungen

Nun folgt man auf der Suchergebnisseite um Abschnitt Results dem Link in der Spalte Entry fur das Protein
mit dem Namen Fasciculin-1, hier also www.uniprot.org/uniprot/POC1Y9

Im Absatz Cross-references wahlt man im Abschnitt 3D structure databases unter PDBe den Entry 1FAS aus,
der auf die Seite www.ebi.ac.uk/pdbe-srv/view/entry/1FAS fuhrt.

Dort kann man im linken Seitenmenu unter Visualisation die Ansicht in Jmol auswahlen. Auf der neuen
Seite www.ebi.ac.uk/pdbe-srv/view/entry/1fas/jmol wahlt man rechts unter Rendering > Rockets aus. Nun
kann man durch einen Rechtsklick auf das Jmol-Applet das Kontextmen( aufrufen und z.B. unter Render >
Disulfide bonds > On die Disulfidbriicken sichtbar machen.

Kennt man die Structure-ID fur die RCSB Protein Data Bank (hier also ,1FAS®), so kann man alternativ
auch unter www.rcsb.org/pdb/ > Search: 1FAS suchen.

Auf der Ergebnisseite www.rcsb.org/pdb/explore/explore.do?structureld=1fas kann man unter dem
Eintrag View in Jmol wieder eine 3D-Ansicht erhalten. Hier kann zusatzlich unter Datei > Exportiere PNG
Abbild die aktuelle Ansicht als Grafikdatei lokal gespeichert werden.



http://www.rcsb.org/pdb/explore/explore.do?structureId=1fas
http://www.rcsb.org/pdb/explore/explore.do?structureId=1fas
http://www.rcsb.org/pdb/
http://www.ebi.ac.uk/pdbe-srv/view/entry/1fas/jmol
http://www.ebi.ac.uk/pdbe-srv/view/entry/1FAS
http://www.ebi.ac.uk/pdbe-srv/view/entry/1FAS
http://www.uniprot.org/uniprot/P0C1Y9
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1.2.4 Membran-Diagramme mit TexTopo am Beispiel Cytochrome b561 domain-containing
protein 1 des Menschen

Auf der Seite www.uniprot.org/uniprot/Q8N8Q1 wahlt man rechts oben den orangefarbenen Knopf
und speichert die Datei als Q8N8Q1.SP

Nun legt man im Programm Texmaker die folgende Datei diagramm_Q8N8Q1 . tex an:

\documentclass[10pt,adpaper]{article}
\usepackage[latin1]{inputenc}
\usepackage{amsmath}

\usepackage{amsfonts}

\usepackage{amssymb}

%TexTopo Paket benutzen

\usepackage{textopo}

\begin{document}

\begin{textopo}

%die unter 1.3.4 gespeicherte Dateil Q8N8Q1.SP benutzen
\getsequence[make new]{SwissProt}{Q8N8Q1.SP}
\end{textopo}

\end{document}

Im Erfolgsfall wird die folgende Grafik in einer PDF-Datei erzeugt:

axtra

@ Polypeptide chain
® Domain

Listen geeigneter Membranproteine bieten die Seiten MPtopo (blanco.biomol.uci.edu/mptopo) und
Stephen White’s Database (blanco.biomol.uci.edu/mpstruc/listAll/list).



http://blanco.biomol.uci.edu/mpstruc/listAll/list
http://blanco.biomol.uci.edu/mptopo
http://www.uniprot.org/uniprot/Q8N8Q1
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1.3 Ubersicht zu Aminosduresequenz- und Proteindatenbanken

UniProt
» Kontrollierte Eintrage v.a. von Aminosauresequenzen von hoher Qualitat von ca. 100 000
Proteinen

* Empfohlene Einstiegsseite, da man Uber die Cross-references schnell zu den ausfihrlicheren
Datenbanken gelangt
e www.uniprot.org

Protein Data Bank (RSCB, PDB = auch als Dateiformat!)
« Datenbank fiir ca. 18000 experimentell ermittelte Proteinstrukturen
* www.rcsb.org/pdb

1.4 Ubersicht zu Dateiformaten fiir Proteine

FASTA

Enthalt die Sequenzinformation fir Aminosaure- oder Nukleotidsequenzen.

Wird von fast allen Programmen verstanden und erzeugt.

Kann mit jedem einfachen Texteditor gedffnet, kopiert und verandert werden.

Beginnt mit einem gréRer als Zeichen ,>“, gefolgt von einer Kennzeichnung des Typs als
Protein/Gen/Alignment in der ersten Zeile: P... = Protein; N...= Nukleinsaure

Dann folgt ein Strichpunkt ,;* und anschlief3end ein eindeutiger Bezeichner.

Jetzt ist noch eine Kommentarzeile méglich, die auf beiden Seiten mit je einem Pipe-Symbol ,|*
eingeschlossen wird.

In der folgenden Zeile folgt dann die eigentliche (méglicherweise sehr lange) Sequenz im reinen
Textformat. Es werden immer GroRRbuchstaben empfohlen. Die Sequenz kann (muss aber nicht) mit
einem Sternchen ,* abgeschlossen werden. Zusatzliche Zeilenumbriche oder Leerzeichen werden beim
Einlesen ignoriert, so dass sie im Bereich der Sequenz fir eine bessere Druckdarstellung beliebig
eingefiigt werden kénnen, ohne dass sich der Informationsgehalt andert.

Ein formal korrektes Beispiel einer FASTA-Datei fur eine Aminosauresequenz wirde also lauten:

>P1;MEINE_KENNZEICHNUNG
|[Mein Kommentartext|
AG*

(entsprechend hier den Aminosauren Alanin und Glycin im Einbuchstabencode)

PDB (Format der Protein Data Bank)

Enthalt die (u.a. rdumlichen) Strukturinformationen von Proteinen.
Eine typische Zeile hat den folgenden Aufbau:

Anzahl Element Molekil Kette X y z Koordinate
ATOM 1 N VAL e 16 29.582 19.112 38.968



http://www.rcsb.org/pdb/
http://www.uniprot.org/
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SP (SWISSPROT; UNIPROT)
Gekirztes Beispiel:

ID (C56D1_HUMAN Reviewed; 229 AA.
AC  Q8N8Q1; B4DH97; Q52M36; Q5T6C2;
DT  10-MAY-2005, integrated into UniProtKB/Swiss-Prot.

[...]
DE RecName: Full=Cytochrome b561 domain-containing protein 1;
[...]

0S Homo sapiens (Human).

0C Eukaryota; Metazoa; Chordata; Craniata; Vertebrata; Euteleostomi;
0C Mammalia; Eutheria; Euarchontoglires; Primates; Haplorrhini;

0C Catarrhini; Hominidae; Homo.

[...]

FT  CHAIN 1 229 Cytochrome b561 domain-containing protein
FT 1.

FT /FTId=PRO_0000151034.

FT  TOPO_DOM 1 24 Cytoplasmic (Potential).

FT  TRANSMEM 25 45 Helical; (Potential).

[...]

FT DOMAIN 22 224 Cytochrome b561.

FT  METAL 55 55 Iron (heme axial ligand) (Potential).
[...]

SQ SEQUENCE 229 AA; 25424 MW; 43978DAF7D8EC218 CRC64;
MQPLEVGLVP APAGEPRLTR WLRRGSGILA HLVALGFTIF LTALSRPGTS LFSWHPVFMA
LAFCLCMAEA ILLFSPEHSL FFFCSRKARI RLHWAGQTLA ILCAALGLGF IISSRTRSEL
PHLVSWHSWV GALTLLATAV QALCGLCLLC PRAARVSRVA RLKLYHLTCG LVVYLMATVT
VLLGMYSVWF QAQIKGAAWY LCLALPVYPA LVIMHQISRS YLPRKKMEM

/1

Die Datenfelder werden durch einen Zweibuchstabencode eingeleitet, nach dem auch bei der Suche
gefiltert wird. Uber den Schliissel DE wird z.B. der Name des Proteins gesucht.

Die Schlussel 0S und OC liefern die systematische Einordnung der Spezies, zu welcher das Protein
gehort. Der Schlissel FT steht fur besondere Bereiche mit bestimmten Eigenschaften, z.B. Stellung
innerhalb oder an einer Membran, Bindungsstellen fir Metallatome/-ionen oder typische Domanen einer
Proteinfamilie. Der Schlissel SQ beinhaltete dann die eigentlichen Sequenzdaten.

1.5 Ubungen

1.5.1 Pre-B-cell Colony- Enhancing Factor (PBEF)

a) Holen der Sequenzdaten
Wahlen Sie auf der Seite www.ncbi.nIm.nih.gov/sites/entrez?db=unigene die Option Protein und suchen

Sie nach dem Stichwort human PBEF . In den Suchergebnissen sollte der folgende Eintrag erscheinen:

nicotinamide phosphoribosyltransferase precursor [Homo sapiens]
491 aa protein

Accession: NP_005737.1

Gl: 5031977

Speichern Sie Uber den Link FASTA die Aminosauresequenz ab unter dem Namen
NP_005737.1_mensch.fasta

Suchen und speichern Sie anschliefend die entsprechenden Sequenzen fir die Ratte (Rattus
norvegicus) [NP_808789.1 ratte.fasta] und die Maus (Mus musculus) [NP_067499.2 maus.fasta].


http://www.ncbi.nlm.nih.gov/sites/entrez?db=unigene
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Damit in den Alignments nicht die komplizierten Accession-Numbers und Kurzbezeichnungen erscheinen,
sondern einfach die Art, wird in jeder Fasta-Datei die erste Zeile z.B. von

>g1|5031977|ref |[NP_005737.1| nicotinamide phosphoribosyltransferase precursor [Homo sapiens]

geandert in:

>gi|Mensch

Dies wird entsprechend auch in den Fasta-Dateien fir Ratte und Maus durchgefiihrt.

b) Durchflhren des Alignments online

Offnen Sie anschlieRend die Seite www.ebi.ac.uk/Tools/msa/clustalw2 und 6ffnen Sie die drei Fasta-
Dateien aus dem letzten Arbeitsschritt mit einem einfachen Texteditor. Kopieren Sie den Inhalt dieser Drei
Dateien in das Feld STEP 1 - Enter your input sequences und wahlen Sie unter STEP 3 - Set your Multiple
Sequence Alignment Options unter More options... > OUTPUT Options > FORMAT: Pearson/FASTA.

Starten Sie anschliefend das Alignment mit Submit.

Speichern Sie auf der Ergebnisseite das Alignment mit Download Alignment File als
mensch_ratte_maus.fasta

c) Stammbaumanalyse online

Offnen Sie die Seite www.ebi.ac.uk/Tools/phylogeny/clustalw2_phylogeny und laden Sie im Feld STEP 1 -
Enter your input sequences unter Durchsuchen die gerade gespeicherte Datei mensch_ratte_maus.fasta
hoch und erzeugen Sie mit Submit einen Baum. Vergleichen Sie wieder die Ansichten als Phylogram und
Cladogram.

d) Stammbaumanalyse offline

Speichern Sie das in der letzten Aufgabe erzeugte Phylogenetic Tree File als stammbaum_PBEF . ph und

offnen Sie diese anschlieRend mit dem Programm NJplot. Machen Sie unter Display > Branch lenghts die
ermittelten Abstande sichtbar und speichern Sie eine A4-Druckversion unter File > Save as Postscript. Die
Dateiendung sollte .ps lauten. Diese Datei kann dann mit einem PDF-Betrachter angesehen oder in ein

Bildbearbeitungsprogramm importiert werden.

e) Alternatives online-Alignment mit anschlieRender Stammbaumanalyse am NCBI [entsprechend c) & d)]

Suchen Sie auf der Seite www.ncbi.nlm.nih.gov/sites/entrez?db=unigene nach dem Stichwort dog PBEF .
In den Suchergebnissen sollte der folgende Eintrag erscheinen:

Nicotinamide phosphoribosyltransferase
NAMPT, Canis lupus familiaris
Cfa.39714: 9 sequences.
Folgen Sie dem Link zu den Nicotinamide phosphoribosyltransferase (NAMPT)-ahnlichen Proteinen

Folgen Sie im Kontextmenu des Eintrags

XP_540386.2 PREDICTED: similar to Nicotinamide phosphoribosyltransferase (NAmPRTase) (Nampt)
(Pre-B-cell colony-enhancing factor 1 homolog) (PBEF)

der Auswahl Protein sequence und in der erscheinenden Seite dem Link FASTA und speichern Sie die
Aminosaure-Sequenz ab unter XP_540386.2_hund. fasta



http://www.ncbi.nlm.nih.gov/protein/73981945?report=fasta
http://www.ncbi.nlm.nih.gov/protein/73981945
http://www.ncbi.nlm.nih.gov/UniGene/clust.cgi?UGID=2674515&TAXID=9615&SEARCH=dog%20PBEF
http://www.ncbi.nlm.nih.gov/sites/entrez?db=unigene
http://www.ebi.ac.uk/Tools/phylogeny/clustalw2_phylogeny/
http://www.ebi.ac.uk/Tools/msa/clustalw2/
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Damit in den Alignments nicht die komplizierte Accession-Number und Kurzbezeichnung erscheint,
sondern einfach die Art, wird auch in dieser Fasta-Datei die erste Zeile z.B. von

>g1|73981945|ref|XP_540386.2| PREDICTED: similar to Nicotinamide phosphoribosyltransferase
(NAmPRTase) (Nampt) (Pre-B-cell colony-enhancing factor 1 homolog) (PBEF) [Canis familiaris]

geandert in:

>gi|Hund

Offnen Sie die Seite mafft.cbrc.jp/alignment/server und kopieren Sie in das Feld Input nacheinander den
Inhalt der vier Dateien:

NP_005737.1_mensch.fasta
NP_808789.1_ratte.fasta
NP_067499.2 maus.fasta
XP_540386.2_hund.fasta

erzeugen Sie mit Submit zunachst das Alignment fur alle vier Arten.
Wahlen Sie auf der Ergebnisseite den Button Phylogenetic Tree und dann Go!
(Bei nur drei Arten im Alignment wird eine Fehlermeldung ausgegeben.)

Wahlen Sie unter Type > unrooted (alpha) und betrachten Sie den folgenden (unrooted = ohne Wurzel)
Stammbaum:

Options Type Help

_nj120802215225001.nh

[»

gi|Mensch

gi|Mau
gi|R atte

gi|Hund

Uncollapse All

Search:

1



http://mafft.cbrc.jp/alignment/server/
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Falls man bereits ein Alignment mit mehr als drei verschiedenen Arten/Proteinen als Fasta-Datei hat,
kann man diese auch gleich unter mafft.cbrc.jp/alignment/server/phylogeny.html zur Erzeugung des
Baumes benutzen.

Eine Kurzibersicht bietet auch die Seite www.cgae.de/alignment/index.html.

f) Druckausgabe des Alignments erzeugen (nur flr Fortgeschrittene!)

Versuchen Sie, wie im Kapitel 1.1.4 beschrieben, eine formatierte Ausgabe des erzeugten Alignments als
PDF-Datei zu erstellen. Legen Sie dazu zunachst im Speicherort der Datei
mensch_ratte_maus. fasta die folgende Datei Alignment_PBEF. tex an:

\documentclass[10pt,adpaper]{article}
\usepackage[utf8]{inputenc}

\usepackage{amsmath}

\usepackage{amsfonts}

\usepackage{amssymb}

%TexShade Paket benutzen

\usepackage{texshade}

\begin{document}

%vorher unter 1.1.3 gespeicherte Datei mensch_ratet_maus.fasta benutzen
\begin{texshade}{mensch_ratte_maus.fasta}
%Zeilenumbruch nach 60 Aminsduren pro Zeile
\residuesperline*{60}

%Einfarbemodus nach Ahnlichkeit/Similarity
\shadingmode[allmatchspecial]{similar}

%Bereichsauswahl von der 1. bis maximal 251. Aminosaure
\setends{1}{1..251}

\hideconsensus

\end{texshade}

\end{document}

1.5.2 Hdmoglobin

Erstellen Sie ein globales Alignment der Aminosauresequenz der a- und 3- Kette des menschlichen
Hamoglobins und protokollieren Sie stichpunktartig die dazu notwendigen Schritte.

Speichern Sie die entsprechenden Aminosaure-Sequenz-Dateien zwischendurch im FASTA-Format lokal
ab.

Tipp: Im Kapitel 5 Workflow ist ein allgemeiner Arbeitsablauf skizziert. Benutzen Sie Werkzeuge |hrer
Wahl, also je nach Systemvoraussetzungen online- oder auch lokal installierte offline-Programme.



http://www.cgae.de/alignment/index.html
http://mafft.cbrc.jp/alignment/server/phylogeny.html
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Zusatzubungen:
- Erzeugen Sie in einem Jmol-Applet drei PNG-Dateien der 3D-Ansicht der beiden verschiedenen Ketten
einzeln sowie eines komplettes Hamoglobin-Molekdls.

- Erzeugen Sie mit Hilfe einer angepassten LaTeX-Datei mit Texmaker eine PDF-Datei mit dem Alignment
der beiden Ketten.

- Folgen Sie auf der Uniprot-Seite der a-Kette www.uniprot.org/uniprot/P69905 im Abschnitt Natural
variations z.B. der in Quong Sze gefundenen Punktmutation an der Position 126, bei der die Aminosaure
Leucin (L) durch die Aminosaure Prolin (P) ersetzt wird. Die veranderte Aminosaure ist farbig
hervorgehoben.

- Im Absatz Cross-references wird nun unter Sequence databases GenBank ausgewahlt und dann gleich der
erste Eintrag J00153

- Uber den Eintrag Related Information > Related Sequences im rechten Seitenmenii werden dann
ahnliche Sequenzen gefunden. Unter dem Stichwort thalassemia (Thalassamie) findet man dort auch
Referenzen zu Erbkrankheiten.


http://de.wikipedia.org/wiki/Thalass%C3%A4mie
http://www.ncbi.nlm.nih.gov/nuccore/J00153
http://www.uniprot.org/blast/?about=P69905[126]
http://www.uniprot.org/uniprot/P69905
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2 Nucleotid-Sequenzvergleiche

Aminosaure-Sequenzen bestehen meist aus etwa 100 bis 500 Bausteinen. Sie haben klar definierte
Begrenzungen und spezifische Funktionseigenschaften. Die dazugehérigen Nukleotid-Sequenzen
hingegen variieren viel starker hinsichtlich ihrer Lange sowie ihrer Verteilung im Genom.

Auf der Nukleinsaure-Ebene enthalt ein Gen also neben den Protein codierenden Abschnitten zusatzlich
(1) Regulatorische Regionen und (2) Bereiche in denen zwar eine Transkription aber keine Translation
mehr stattfindet. Bei Eukaryoten sind die Protein codierenden Abschnitte zusatzlich noch aufgeteilt in
eine unterschiedliche Anzahl von (3) Exons, also Bereichen, welche zum spateren Protein beitragen
sowie (4) Introns, die vorher beim SpleilRen ausgeschnitten werden.

Nukleotid-Sequenzen kénnen sich daher beziehen auf entweder

(1) primare Transkripte vor dem Speif3en, die noch alle Introns und Exons enthalten,

(2) den Abschnitt entsprechend der reifen mRNA, welche nur noch die Exons enthalt,

(3) den offenen Leserahmen (OLR) zwischen einem Start- und einem Stop-Codon, der sowohl Introns als
auch Bereiche enthalt, die zwar transkribiert aber nicht translatiert werden, oder auf

(4) eine Vielzahl von mdglichen Teilsequenzen.

Hieraus ergeben sich zwei wesentliche Folgen fur den Arbeitsablauf:
1. Es wird soweit mdglich zuerst das Protein gesucht und erst dann werden Uber Querverweise
(Cross-references) die Nukleotid-Sequenzen aufgerufen.
2. Bei Proteinen ist haufig ein globales Alignment (lber die gesamte Lange) sinnvoll, wahrend bei
Nukleotid-Sequenzen meist nur lokale Alignments (mit kiirzeren Bruchstlicken) sinnvoll sind.

2.1 dUTP pyrophosphatase von E. coli

2.1.1 Suche in der UniProt-Proteindatenbank
www.uniprot.org > Tab: Search > Suchbegriff: dUTP pyrophosphatase

Entry Entry name Status Protein names Gene names Organism Length
P06968 DUT_ECOLI Deoxyuridine 5'-  dut dnaS sof Escherichia coli 151
- triphosphate b3640 (strain K12)

nucleotidohydrol.. JW3615

Nun folgt man dem Eintrag auf die Seite www.uniprot.org/uniprot/P06968
und scrollt auf der Seite nach unten bis in den Absatz Cross-references.

Im Abschnitt Sequence databases wahlt man die Option GenBank aus und folgt dem GenBank Eintrag mit der
Accession Number X01714 auf die Seite www.ncbi.nlm.nih.gov/nuccore/X01714

Uber den Link FASTA kann wird nun die Fasta-Nukleotid-Sequenzdatei X01714_ecoli.fasta
gespeichert.

2.1.2 Nukleotid-Sequenzen im FASTA-Format herunterladen

Nun werden die unter 2.1.1 beschriebenen Schritte immer mit dem ersten GenBank Eintrag fur die
folgenden Arten wiederholt, so dass man am Ende insgesamt sechs verschiedene Nukleotid-Sequenz-
Fasta-Dateien erhalt:



http://www.ncbi.nlm.nih.gov/nuccore/41296?report=fasta
http://www.ncbi.nlm.nih.gov/nuccore/X01714
http://www.ncbi.nlm.nih.gov/entrez/viewer.fcgi?db=nuccore&id=X01714
http://www.uniprot.org/uniprot/P06968
http://www.uniprot.org/uniprot/P06968
http://www.uniprot.org/
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UniProt Art NCBI Fasta-Dateiname
Entry name Accession Number
DUT_AQUAE | Aquifex aeolicus AE000657 AE000657.1_aquifex.fasta
(strain VF5) komplettes Genom!
(thermophiles
Bakterium)
DUT_BRAJA |Bradyrhizobium AF042096.3 AF042096.3_bradyrhizobium. fasta
japonicum mehrere Gene
DUT_BPT5 |Bacteriophage TS5 |AY543070.1 AY543070.1_bacteriophaget5.fasta
komplettes Genom!
DUT_CANAL |Candida albicans AACQO01000045.1 AACQ01000045.1_candida.fasta
SC5314 (Hefepilz) |komplettes Genom!
DUT_BUCAI |Buchnera aphidicola | BAO00003.2 BA000003.2_buchnera.fasta
str. APS komplettes Genom!
(Acyrthosiphon
pisum)

Tipp: Langere Fasta-Sequenzen kdnnen unter Send > Choose Destination > File > Format: FASTA > Create
File heruntergeladen werden, kiirzere kann man auch einfach markieren und in ein leeres Textdokument
in einem einfachen Texteditor wie Gedit oder Geany einfiigen.

2.1.3 Nukleotid-Sequenzvergleich mit BLAST

Far den Sequenzvergleich wird hier eine online-Version von BLAST genutzt.

Auf der BLAST-Startseite des NCBI http://blast.ncbi.nim.nih.gov/Blast.cgi findet man die folgende Option:
nucleotide_blast, welche die Nukleotid-Datenbank nach ahnlichen Stellen zu einer gegebenen Nukleotid-
Sequenzen durchsucht.

Dabei treten zwei Probleme auf:

(1) Werden homologe Sequenzen Ubersehen? Dies kann passieren, wenn man zu spezifisch sucht;

(2) Werden falsche Sequenzen mitgefunden? Dies kann passieren, wenn man zu unspezifisch sucht.

= Es muss immer ein Kompromiss aus (1) Spezifitat und (2) Sensitivitat gefunden werden!

Fragestellung 1:
In welchen Organismen ist allgemein eine zum dUTP pyrophosphatase-Gen von E. coli dhnliche
Nukleotid-Sequenz enthalten?

* In das obere Feld Enter Query Sequence wird nun zunachst die Accession Number des E. coli Gens
kopiert:
X01714

* Die Option Align two or more sequences wird NICHT ausgewahlt.

* Im Abschnitt Choose Search Set wird unter Database Others (nr etc.): Nucleotide colelction (nr/nt)
ausgewahlt. Hinweis: nr steht fir nonredundant, die Suche lauft also Uber alle bekannten
Nukleotid-Sequenzen.

* Im Abschnitt Program Selection wird unter Optimize for ausgewahlt Somewhar similar sequences
(blastn)

* Nach Drucken des grofien BLAST-Knopfes ganz unten links, kann es mehrere Minuten dauern,
bis eine Ergebnisseite erscheint.

Die Interpretation ist hier leider nicht mehr so einfach wie bei den Aminosaure-Seugenzvergleichen.
Wichtig fiir eine gute Ubereinstimmung sind allgemein ein hoher Wert in der Spalte Total Score sowie ein
maoglichst niedriger Wert in der Spalte E value (E = Expect-Wert, E = 0,02 = vermutlich homolog, E = 1
= die gefundene Ubereinstimmung beruht vermutlich auf Zufall).


http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastn&BLAST_PROGRAMS=megaBlast&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&LINK_LOC=blasthome
http://blast.ncbi.nlm.nih.gov/Blast.cgi
http://www.geany.org/
http://projects.gnome.org/gedit/
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Identische Sequenzen sind natirlich zu 100% identisch und die Wahrscheinlichkeit beim Abgleich mit
ganzen Genomen ist ebenfalls viel hdher als mit einzelnen Gensequenzen.

Fragestellung 2:
Ist in einer der fiinf anderen Gensequenzen aus Kapitel 2.1.2 eine dem dUTP pyrophosphatase-Gen von

E. coli dhnliche Nukleotid-Sequenz enthalten?

* In das obere Feld Enter Query Sequence wird nun zunachst die Accession Number des E. coli Gens
kopiert:
X01714

* Die Option Align two or more sequences wird jetzt ausgewahilt.

* Im erscheinenden Abschnitt Enter Subject Sequence wird bei jedem Testdurchlauf EINE der
folgenden Accession-Numbers eingegeben:
AE000657 ODER AF042096.3 ODER AY543070.1 ODER
AACQO01000045.1 ODER BA000003.2

* Im Abschnitt Program Selection wird unter Optimize for ausgewahlt More dissimilar sequences
(discontiguous megablast)

* Nach Driicken des gro3en BLAST-Knopfes ganz unten links, kann es mehrere Minuten dauern,
bis eine Ergebnisseite erscheint.

Im Erfolgsfall erscheint auf der Ergebnisseite im Abschnitt Graphic Summary unterhalb des oberen
durchgezogenen roten Balkens, der die vorgegebene Abfragesequenz darstellt, eine oder viele Linien fur
gefundene Alignments.

Die Lange der Balken zeigt an, wie lange die gefundene Sequenz im Vergleich zur vorgegebenen
Abfragesequenz ist. Die Farbe des Balkens zeigt den Grad der Ahnlichkeit an (Bei Nukleotidsequenzen in
Prozent Identitét, bei Aminosauresequenzen in Prozent Ahnlichkeit/Similarity).

Im Abschnitt Alignments wird eine genauere Ansicht fir jedes dieser gefundenen Alignments gegeben,
etwa in der Form:

>dbj|BAOOEOO3.2| Download subject sequence BAOQEOOO3 spanning the HSP Buchnera aphidicola
str. APS (Acyrthosiphon pisum) genomic DNA,

complete sequence

Length=640681

Score = 68.0 bits (74), Expect
Identities = 81/110 (74%), Gaps
Strand=Plus/Minus

3e-12
0/110 (0%)

Query 545 TGCCGCGCTCCGGATTGGGACATAAGCACGGTATCGTGCTTGGTAACCTGGTAGGATTGA 604

LOCE T e bt et et et 1|
Sbjct 593108 TGCCTAGGTCTGGACTAGGTCATAAAAAAGGTATTGTACTAGGTAATTTAGTTGGTTTAA 593049

Query 605 TCGATTCTGACTATCAGGGCCAGTTGATGATTTCCGTGTGGAACCGTGGT 654

[ LR e e FEeeeeer i e |
Sbjct 593048 TTGATTCTGACTATCAAGGTCAATTGATGATATCTCTCTGGAATCGTAGT 592999
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2.2 Dateiformate fiir Nukleotidsequenzen

FASTA

Vgl. Kapitel 1.4

Enthalt die Sequenziformation fir Nukleotid- oder Aminosauresequenzen.

Ein formal korrektes Beispiel einer FASTA-Datei fir eine Nukleotidsequenz wirde also lauten:

>N1;MEINE_KENNZEICHNUNG
|Mein Kommentartext|
AUG GCG UAG*

(entsprechend der mRNA fur: Met/Start-Ala-Stop)

2.3 Ubersicht zu Nukleotidsequenz- und Gendatenbanken

European Molecular Biology Laboratory (EMBL)
* Umfassende Datenbank mit mehr als 20x10° Eintragen
* Die Inhalte werden mit der DNA Database of Japan DDBJ (www.ddbj.nig.ac.jp) und der
GenBank des National Center for Biotechnology Information NCBI
(www.ncbi.nlm.nih.gov/gene) abgeglichen
* www.ebi.ac.uk/embl

Nucleotide Database am National Center for Biotechnology Information
e Fur kurzere Nukleotid-Sequenzen
e www.ncbi.nim.nih.gov/nuccore

2.4 Ubungen

Tipp: Alternativ kann neben der NCBI-Seite blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastn auch das
BLAST-online Werkzeug der Seite
www.ebi.ac.uk/Tools/sss/ncbiblast/nucleotide.html genutzt werden.

2.4.1 Zu welchem Enzym gehért ein bestimmtes DNA-Fragment?

Gegeben ist das folgende Fragement einer DNA-Sequenz aus einem wichtigen Enzym des Menschen

>N_Fragmentl
TGTCGCACAG ATGACCACGT GGTTAGTGGC AACCTGGTGA CCCCCCTTCC TGTGATTTTA

>N_Fragment2
GGTGATAAAG TCATCCCGCT CTTTACTCCT CAGTGTGGAA AATGCAGAGT TTGTAAAAAC
CCGGAGAGCA ACTACTGCTT GAAAAATGAT CTAGGCAATC CTCGGGGGAC CCTGCAGGAT

Ermitteln Sie fur beide DNA-Fragmente jeweils getrennt voneinander und jeweils mit Hilfe der beiden
angegebenen BLAST-Seiten, zu welchem Enzym des Menschen dieses DNA-Fragement vermutlich
gehort.



http://www.ebi.ac.uk/Tools/sss/ncbiblast/nucleotide.html
http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastn
http://www.ncbi.nlm.nih.gov/nuccore
http://www.ebi.ac.uk/embl/
http://www.ncbi.nlm.nih.gov/gene
http://www.ddbj.nig.ac.jp/
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2.4.2 Homologe Gene, die in Eukaryoten konserviert sind

Vergleichen Sie auf der Seite www.ncbi.nlm.nih.gov/sites/homologene/37552 die im Absatz Protein-
Alignments im Kasten Pairwise alignments generated uning BLAST das Protein-Alignment zwischen
NP_001017916.1 (H. sapiens) und NP_031831.2 (M. musculus).

>ref|NP_031831.2| cytochrome b561 [Mus musculus]

sp|Q60720.2|CY561_MOUSE RecName: Full=Cytochrome b561; AltName: Full=Cytochrome b-561
dbj|BAB29321.1| unnamed protein product [Mus musculus]

6 more sequence titles

Length=250

Score = 387 bits (993), Expect = 1le-140, Method: Compositional matrix adjust.
Identities = 210/233 (90%), Positives = 219/233 (94%), Gaps = 0/233 (0%)

Query 19  FSQLLGLTLVAMTGAWLGLYRGGIAWESDLQFNAHPLCMVIGLIFLQGNALLVYRVFRNE 78
FSQLLGLT+VA+TGAWLGLYRGGIAWES LQFN HPLCMVIG+IFLQG+ALLVYRVFR E
Sbjct 18  FSQLLGLTVVAVTGAWLGLYRGGIAWESSLQFNVHPLCMVIGMIFLQGDALLVYRVFRRE 77

Query 79  AKRTTKVLHGLLHIFalvialvglvavFDYHRKKGYADLYSLHSWCGILVFVLYFVQWLV 138
AKRTTK+LHGLLH+FA +IALVGLVAVFDYH+KKGYADLYSLHSWCGILVFVLYFVQWLV
Sbjct 78  AKRTTKILHGLLHVFAFIIALVGLVAVFDYHKKKGYADLYSLHSWCGILVFVLYFVQWLY 137

Query 139 GFSFFLFPGASFSLRSRYRPQHIFFGATIFLLSVGTALLGLKEALLFNLGGKYSAFEPEgG 198
GFSFFLFPGASFSLRSRYRPQHIFFGATIFL SVGTALLGLKEALLF LG KYS FEPEG
Sbjct 138 GFSFFLFPGASFSLRSRYRPQHIFFGATIFLFSVGTALLGLKEALLFKLGSKYSTFEPEG 197

Query 199 vlanvlglllaCFGGAVLYILTRADWKRPSQAEEQALSMDFKTLTEGDSPGSQ 251
VLANVLGLLL CFG VLYIL +ADWKRPSQAEEQALSMDFKTLTEGDSP Q
Sbjct 198 VLANVLGLLLVCFGVVVLYILAQADWKRPSQAEEQALSMDFKTLTEGDSPSPQ 250

Begriinden Sie, woran man erkennen kann, dass in diesem Fall auch ein globales Alignment gut geeignet
gewesen ware!

Fuhren Sie wie in Kapitel 1 beschrieben auf der Seite www.uniprot.org ein solches globales Alignment mit
www.ncbi.nlm.nih.gov/protein/630548307?report=fasta und www.ncbi.nlm.nih.gov/protein/315424367?
report=fasta durch und vergleichen Sie das dortige Ergebnis mit dem oben angegebenen Ergebnis der
BLAST-Abfrage.



http://www.ncbi.nlm.nih.gov/protein/31542436?report=fasta
http://www.ncbi.nlm.nih.gov/protein/31542436?report=fasta
http://www.ncbi.nlm.nih.gov/protein/63054830?report=fasta
http://www.uniprot.org/
http://www.ncbi.nlm.nih.gov/sites/homologene/37552
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3 Fachbegriffe und Abkirzungen

Globales Alignment

Es wird die Sequenz der Bausteine eines polymeren Biomolekils tUber seine volle Lange hinweg
verglichen.

Bei unterschiedlicher Kettenlange werden in der kiirzeren Kette die jeweils fehlenden Glieder als
Ubersprungen gekennzeichet (z.B. durch einen Punkt oder ein Minuszeichen).

z.B. eine komplette Polypeptidkette eines Proteins einer Art mit dem entsprechenden Protein einer
anderen Art order zwei verwandte Polypeptidketten nur einer Art.

z.B. der Exon-Bereich eines Gens

z.B. eine mRNA

Beispiel fiir ein globales (paarweises) Alignment:

KIEGKNVFYWFQNHKARERQKKR - -

I I T O I Y I PO
KLAGK - - FYWYNKHKAYWFQNKHAR

Ein Pipe-Symbol | (oder ein Sternchen *) bedeutet vollige Ubereinstimmung, ein Doppelpunkt : sehr
ahnlich, ein einfacher Punkt . ahnlich. Aminosauren, die nur in einer Kette vorkommen, werden mit einem
Bindestrich - gekennzeichnet.

Die fettgedruckten Aminosauren werden unten im Beispiel fir ein lokales Alignment verwendet.

Beispiel-Programm: "GAP" (Needleman & Wunsch)

Lokales Alignment

Es werden nur kurze Abschnitte einer bestimmten Lange mit einer bestimmten Sequenz gesucht.
Moglicherweise kdnnen diese auch mehrfach vorkommen. Durch Insertion oder andere
Genommutationen kénnen sie auch unterschiedlichen Stellen innerhalb eines Gens vorkommen.

Beispiel fur ein lokales (paarweises) Alignment:
YWFQNHKAR

[TTETLT]
YWFQNHKAR

Paarweises Alignment
Es werden nur zwei Sequenzen miteinander verglichen (z.B. gleiches Protein zweier Arten vgl. Kapitel 1.1
und 1.2 oder unterschiedliches Protein einer Art, vgl. Kapitel 1.5 Ubung 1.5.1).

Multiples Alignment
Es werden mehrere Sequenzen miteinander verglichen (z.B. entsprechende Proteine bei mehreren
Arten).

FASTA

Dateiformat fiir Aminosaure- oder Nukleotid-Sequenzdaten einzelner Polypeptidketten oder DNA- oder
mRNA-Sequenzen oder auch paarweiser oder multipler Alignments; bezeichnet gleichzeitig auch den
Algorithmus fiir globale Alignments

FastA (Fast Alignment, Pearson u. Lipmann 1998)

GDE format
genau wie FASTA, aber beginnend mit einem Prozentzeichen "%" an Stelle eines gréRer als Zeichens ">"

BLAST (Basic Local Alignment Search Tool, Altschul et al. 1990)
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Weit verbreiteter Algorithmus (und Software) fiir schnelle und trotzdem zuverlassige lokale Alignments
Multiple Sequence Format (MSF)

Ausgabeformat fur Alignments, die mit Hilfe des Programms PHYLIP (phylogenetic inteference package,
evolution.genetics.washington.edu/phylip.html) erzeugt wurden.

ALN format
Ausgabeformat fur Alingments, die mit Hilfe des Programms CLUSTALW/X erzeugt wurden.

PHYLIP FORMAT TREE (Phylogenetic Tree File, Dateiendung: .ph)
z.B. die Datei cytochromvergleich_baum.ph aus Kapitel 1.1.5

(

(

sp|POABE5|C561_ECOLI:0.00000,
sp|POABE6 | C561_SHIFL:0.00000)
:0.72747,
sp|P49447|CY561_HUMAN:0.04226,
sp|Q60720|CY561_MOUSE:0.08174);

Ahnlichkeit (Similarity)

MaR fiir die Ubereinstimmung verschiedender Aminoséure-Sequenzen. Hierbei werden neben den
Zahlenverhaltnissen v.a. die Eigenschaften der verschiedenen Aminosauren (z.B. Hydrophilie, Polaritat,
pKS-Wert und Ladung bei bestimmten pH-Werten) mit beriicksichtigt. Sie wird in Prozent angegeben.
Hinweis: Eine Homologie ist nur eine von mehreren méglichen Ursachen fiir eine solche Ahnlichkeit.

ILVCAGMFYWHKREQDNSTP Aminosadure (Einbuchstabencode)

XXXXXXXXXXK + v eee e X- Hydrophober Rest
-------- XXXXXXXXXX+X Polarer Rest
XXX e XXXXX Kleiner Rest
................... X Prolin

ce e XX X-+ Sehr kleiner Rest
XXX Kettenférmiger Kohlenwasserstoffrest
------- XXXX+-+++---+ Aromatischer Rest
.......... XXX:-----+ Positive Ladung
............. X-X---+ Negative Ladung
---------- XXXX-X---- Geladen
Homologie (Homology)

Die betrachteten Sequenzen besitzen einen gemeinsamen Voraufersequenz (vgl. Orthologie). In
Ausnahmefallen kénnen sie sich sogar stark unterscheiden, etwa wenn auf Proteinebene inzwischen
andere Funktionen erfillt werden. Im Gegensatz zu nicht identischen Nukleotiden, kénnen auch nicht
identische Aminosauren kénnen einen evolutiondren Bezug haben. Dies ist dann von ihren Eigenschaften
abhangig (s.o. Ahnlichkeit/Similarity).

Identitat (Identity)

Gib den Anteil der identischen Bausteine (Aminosauren oder Nukleotide) in einer Sequenz einer
bestimmten Lange in Prozent an.


http://evolution.genetics.washington.edu/phylip.html
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Orthologie
Sequenzahnlichkeit aufgrund eines evolutionaren Zusammenhangs
(z.B. ein bestimmtes Enzym beim Menschen und bei der Maus)

Vorfahre

Seq. A Seq. B

Paralogie
Sequenzahnlichkeit aufgrund einer Gen-Duplikation
(z.B. zwei Kinasen des Menschen in verschiedenen Signallubertragungswegen)

Vorfahre

/

Seq.A ————» Seq.B

Analogie
Sequenzahnlichkeit aufgrund evolutionarer Konvergenz/ahnlicher Funktion
Vorfahre Vorfahre
Seq. A Seq. B

Xenologie )
Sequenzahnlichkeit aufgrund der Ubertragung/Aufnahme artfremder Gene z.B. durch ein Virus (z.B.
Resistenzgene auf Plasmiden)

Virus mit B Seq. B Seq. A
Zelle

Vereinfachungen:

* Aminosauren haben verschiedene chemische Eigenschaften, welche ihre relative
Vertauschbarkeit beeinflussen (z.B. Hydrophilie, Polaritat, pKS-Wert und Ladung bei bestimmten
pH-Werten).

» Mehrfachsubstitutionen, die bewirken, dass z.B. nach einer Anderung an einer Position nach einer
erneuten Anderung wieder der urspriingliche Baustein an der entsprechenden Position steht,
werden hier nicht bertcksichtigt.

* Da sehr viele lokale Alignments mdglich sind, ist ein aufwandiges Scoring notwendig, um diese
Méglichkeiten zu bewerten. Dessen zugrundeliegenden Ahnlichkeitsmatrizen (Score Matrices)
werden hier nicht thematisiert.

* Fir die Bewertung alternativer Stammbaumvarianten ist das Parsimonieprinzip nutzlich, das
besagt, dass man mit mdglichst wenigen Sequenzanderungen (und Stammbaumverzweigungen)
ans Ziel kommen sollte.

* Der Unterschied zwischen phylogenetischen Stammbaumen und statistischen Abstandsbaumen
wird hier nicht thematisiert.
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4 Software

4.1 Texmaker, Texshade und Textopo (Druckausgabe von Alignments)

Installation unter Ubuntu- oder Debian-Linux:

sudo apt-get install texmaker texlive-science
Die Dokumentation liegt dann in den Verzeichnissen:
/usr/share/doc/texlive-doc/latex/texshade
/usr/share/doc/texlive-doc/latex/textopo

Installation unter Windows:

www.xm1math.net/texmaker

www.miktex.org

www.uni-kiel.de/pharmazie/chem/Prof Beitz/dtse.htm
www.uni-kiel.de/pharmazie/chem/Prof Beitz/textopo.htm

4.2 Clustalx (globale und lokale Alignments erzeugen)

Installation unter Ubuntu- oder Debian-Linux:
sudo apt-get install clustalx
Installation unter Windows:
www.clustal.org/clustal?

4.3 NJplot (Baume anzeigen und Druckausgabe erzeugen)
Installation unter Ubuntu- oder Debian-Linux:
sudo apt-get install njplot

Installation unter Windows:
pbil.univ-lyon1.fr/software/njplot

Baume konnen alternativ auch tber den folgenden Webservice angezeigt werden:

www.ebi.ac.uk/Tools/phylogeny/clustalw2_phylogeny

4.4 Emboss (globale und lokale Alignments erzeugen)

Installation unter Ubuntu- oder Debian-Linux:
sudo apt-get install emboss jemboss

An Stelle einer Installation wird unter Windows die Benutzung des entsprechenden Webservices

empfohlen:
www.ebi.ac.uk/Tools/webservices

4.5 PHYLIP (PHYLogeny Inference Package)

Installation unter Ubuntu- oder Debian-Linux:

sudo apt-get install phylip embassy-phylip
Installation unter Windows:
evolution.genetics.washington.edu/phylip.html

4.6 MAFFT (Multiple alignment program for amino acid or nucleotide sequences)

Installation unter Ubuntu- oder Debian-Linux:
sudo apt-get install mafft

Installation unter Windows oder online-Nutzung:
mafft.cbrc.jp/alignment/software
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http://mafft.cbrc.jp/alignment/software/
http://evolution.genetics.washington.edu/phylip.html
http://www.ebi.ac.uk/Tools/webservices/
http://www.ebi.ac.uk/Tools/phylogeny/clustalw2_phylogeny/
http://pbil.univ-lyon1.fr/software/njplot
http://www.clustal.org/clustal2/
http://www.uni-kiel.de/pharmazie/chem/Prof_Beitz/textopo.htm
http://www.uni-kiel.de/pharmazie/chem/Prof_Beitz/dtse.htm
http://www.miktex.org/
http://www.xm1math.net/texmaker/
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4.7 Archaeopteryx (Baume anzeigen und bearbeiten)

Plattform Ubergreifendes Java basiertes Standalone-Programm oder Browser-Applet:
www.phylosoft.org/archaeopteryx

Tipp: Das Metapaket science-biology enthalt noch viele weitere Programme zur Bioinformatik!


http://www.phylosoft.org/archaeopteryx/
http://java.com/de/
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5 Workflow

5.1 Aminoséaure-Sequenzen

Datenbanksuche
www.uniprot.org
www.ebi.ac.uk/embl

Textsatz
Texmaker
MikTeX

PDF-Datei

LaTeX-Datei (.tex)

- Fasta-Datei (.fasta)
mit Sequenzinformationen

| Protein Data Bank (.pdf/.ent) 3D-Viewer PNG-Datei
mit Raumstrukturinformationen JmolApplet
Yy v

Sequenzalignment \
Online oder z.B. mit
- ClustalX
- Jemboss
- MAFFT J

I P  Fasta-Datei (.fasta)
L mit Sequenzinformationen

Stammbaum
Online oder z.B. mit
- NJplot
- PHYLIP/Jemboss
- MAFFT

p Phylogenetic Tree File (.ph) PS-Datei
mit Abstandsinformationen
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5.2 Nukleotid-Sequenzen

Protein-Datenbanksuche
www.uniprot.org
www.ebi.ac.uk/embl

y

Cross-References
Nukleotid-Datenbankeintrag

- Fasta-Datei (.fasta)
mit Sequenzinformationen

A | y

Lokales Alignment
mit BLAST (Online)
blast.ncbi.nim.nih.gov/Blast.cgi
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